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1 INTRODUCTION 
This document covers the operation of the Model 105 Current Meter, when used with DataLog PC software.  
DataLog software is also compatible with other Valeport instruments, so the user may find functions that are 
unavailable with this instrument.  These functions are for use with other Valeport instruments only, and are 
not covered in this manual. 
 

1.1  DESCRIPTION 

DataLog is an event driven program written in VISUAL BASIC FOR WINDOWS for use with Valeport data 
gathering instruments.  The program allows the user to configure the sampling regime of the instruments, view 
data in real time using a selection of displays, and extract and view data from logging instruments.  The new 
extended memory 105 must be run with a version of DataLog no later than version N.   
 
If you do not have a copy of this software, please consult Valeport Ltd. 
 
Available displays include real time only displays for measured and calculated parameters (if applicable) 
tabulated scroll, and graphical output.  The user can select suitable scales for the graphical displays.  
 
Additional features of DataLog include: 

 
•  Recording of real time data to PC. 
•  Printing of data (tabulated scroll and graphs). 
•  Test Formula function to allow data checks. 
•  Simple statistical analysis of data. 
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2 INSTALLATION 

2.1 INSTALLING DATALOG 

It is recommended that an IBM compatible PC of 486 DX2 level or above is used, with Windows 3.1 or 
above.  It is advisable to have at least 8Mb RAM fitted; software will operate with a standard 4Mb, but 
opening too many windows may cause system to "hang up".  
The new extended memory 105 must be run with a version of DataLog no later than version N.   
 
If you do not have a copy of this software, please consult Valeport Ltd. 
 
To install DataLog follow the procedures as described below. 
 

•  Place the installation disk in drive A. 
•  Enter WINDOWS Program Manager. 
•  Select File using the mouse or Alt F. 
•  Use mouse to select Run or press the R key. 
•  In the command line type A:SETUP  followed by <CR>. 
•  A Dialog box will appear with the message INITIALISING SETUP. 
•  After a few seconds you will be asked to select the path and directory in which to install DataLog. 
•  Select Continue to select default DataLog directory. 

 
The installation will now commence. When finished an OK prompt will appear with the message 
INSTALLATION IS COMPLETE. The DataLog program is now available for use under the Program Manager. 
 

2.2 PC SETUP 

In order for DataLog to operate correctly, the format of the date, time and numbers must be correctly set 
within the Windows Control Panel. 
 

Function Format Example 
Date  dd/MM/yy 23/09/96 
Time  HH:mm:ss (24 hr clock) 16:37:20 
Numbers: Decimal Mark . 1.25 
 Thousands separator , 1,321,000 

 
Failure to set the above parameters correctly may result in the software being unable to 
read data from the instrument. 
 
Flow charts on the next two pages indicate the principle steps in operating the instruments in Self Recording 
and Direct Reading (if available) modes.  For more detailed explanations and instructions please refer to 
Sections 3 & 4. 
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FIGURE 1 OPERATION OF MODEL 105 IN LOGGING MODE 
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FIGURE 2 OPERATION OF MODEL105 IN DIRECT READING MODE 
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3 SETUP 
In order to operate the unit, the first step is to correctly configure it using the Setup pull down menu in the 
opening DataLog screen. This menu contains all controls necessary for communication with the instrument, 
setup of sampling regime, and data extraction. 
 

3.1 PORT 

Communications are via RS232 comms port.  It is necessary to set the comms port configuration before any 
communications can be achieved.  Do this by selecting Port from the Setup menu.  The following display will 
be shown: 
 

 
 
Select the correct comms port number using the mouse.  Note that the default baud rate is 4800.  For 
reference, the communications are preset to 8 data bits, 1 stop bit and no parity; these are not user 
changeable. 
 
Note the presence of the check box marked RS485.  The Model 105 do not have the option to communicate 
in this mode - the box should be left unchecked. 
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3.2 CONNECT 

The Model 105 is supplied with a short length of wire with two crocodile clips fixed to either end.  When 
using the instrument in air, it is necessary to attach the clips to the two pins at the tail end of the unit.  This 
simulates the shorting of the pins that occurs when the unit is submerged in water.   
 
When attaching the crocodile clips to the pins ensure that it is the two shorting pins that are used and not the 
thermistor, which looks similar but is slightly longer.  This is effectively the ‘on/off’ switch and 
communications will not be initiated unless these pins are shorted either by the wire or by submerging the 
unit in water. 
 
Having correctly configured the comms port, it is possible to communicate with the instrument. 
Select Connect from the Setup menu. 
 
A Dialog box similar to that shown below will appear.  Confirmed in the title block are the instrument type (in 
this case, Model 105 fitted with Temperature and Depth sensors) and the serial number of the unit (20356).  
This box allows changes to be made to the unit's setup.  The different options are detailed below.   
 
NOTE: If the Set command is not implemented, the changes will not be made in the instrument. 
 

 
 
 
It is also possible to return to Connect stage from Run mode, if changes need to be implemented.  Run mode 
must then be reselected once changes have been set. 
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3.3 PROBE CONFIGURATION 

The amount of total memory and the amount available for recording data is shown together with the probe 
date/time. In the above example, the unit has a total of  518,000 bytes of  which 517, 448 bytes are unused. 
 

3.4 SAMPLE MODE 

The only sample mode available on the Model 105 Current Meter is TIME sampling.  The instruments operate 
on a minimum one second cycle, during which they measure the speed of the flow, and take a single 
compass reading, and read any optional sensors fitted.  The length of this cycle can be set by the user to any 
number of whole seconds, using the Sample Period box.  For example, entering 10 in this box will set the 
sampling cycle to 10 seconds.  This means that the unit will read data from each sensor once every 10 
seconds. 
 
The user is also required to set the Average Period.  This is set by the user to be the number of Sample Periods 
over which the data is averaged.  Continuing the above example, setting an Average Period of 6 means that 
the data will be averaged every 6  Sample Periods, i.e. every minute. 
 
The only data that is displayed or logged is the average value obtained at the end of the Average Period.  If 
the user wishes to log every sample taken, Average Period must be set to 1. 

3.5 MODE 

DataLog offers three operating modes - Direct Reading, Logging or Both.  The Model 105 are self recording 
instruments as standard.  As such, only Logging mode will be available.  If the optional Direct Reading 
capability is fitted to the instrument, all three operating modes will be available.  In this case it is also possible 
to record Direct Reading data to disk.  See Section 4.1 for details of how to do this. 
 

i) Dir  This is Direct reading where the data is transmitted in real time mode in intervals defined by 
the sampling setup. 

 
ii) Log This Logging mode stores averaged data in the instrument RAM in intervals defined by the 

sampling setup. No data will be transmitted in this mode. 
 
iii) Dir & Log This mode performs i) and ii)  i.e. realtime data is transmitted and stored to internal RAM. 

 
Select the desired operating mode by clicking on the relevant option with the mouse. 
 
N.B. Do not select Dir & Log Mode unless the communications lead will be connected throughout the 

deployment or test.  Removing the communications lead whilst the unit is running in this mode will 
result in fragmented data files. 
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3.6 PRESSURE TARE SETTING (IF FITTED) 

The Model 105 can have a pressure sensor fitted as an option.  All pressure measurements are related to 
absolute. Prior to deployment the tare pressure can be set. To set the current tare pressure, select  Pressure in 
the Sensor Configuration window. The current calibration and pressure tare will be displayed. Select Set Tare, 
the instrument will read the current absolute pressure and then adjust all subsequent pressure readings by this 
amount so they are referenced to the sea level pressure at the time of deployment. 
 
 

 
 
 

3.7 OTHER PARAMETER INFORMATION 

Similar Dialog boxes will appear for the optional Temperature sensors, showing the current calibration 
details.  These cannot be altered in DataLog.  For details of how to change calibration data, refer to the main 
Unit Operation Manual. 
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3.8 MISCELLANEOUS 

3.8.1 BAUD RATE 

When uploading data, the baud rate limits the time taken. To speed the transfer process up, the baud may be 
changed to a higher rate than the standard 4800. It must be stressed that the cable lengths and the type of 
communications being used may restrict the maximum baud rate. If an upload error occurs, reduce the baud 
rate and retry. 
 
For example, if using a short 'Y' lead to set up the instrument or extract data, 19200 should be acceptable 
assuming the PC in use can support this.  When using very long cable lengths with current loop 
communications for example, the data rate may need to be slowed down to 1200 baud for successful 
protocol. 
 
It should be noted, however, that the instrument will always start at 4800 baud from switch on. 
 

3.9 LOGGED DATA 

The user also has the option to Upload Logged Data from the unit.  Full details on how to do this are given in 
Section 5.1. 
 

3.9.1 CLEAR FILES 

Click on this button to Erase the memory of the unit.  A confirmation is displayed, and clicking on OK erases 
memory. 
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3.10 SET FILE INFORMATION 

 
The last function that can be performed in the Setup Menu is to specify the Site Information for each File 
contained within a Self Recording unit's memory.  Clicking on this button reveals the following display: 
 
 

 
On the right hand side is a list of all files contained within the fish memory, and their sizes.  To change or 
view the information of any file, click on that File with the mouse, or alternatively type the File name into any 
of the Old File Name boxes on the screen. 
 
Having selected a File, the user has the option to change the File name, view current Site Information (Get 
Info), or set new File Information (Set Info).  This information is contained within a header record for each File 
within the unit's internal memory. 
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4 RUN MODE 

4.1 RUNNING THE INSTRUMENT 

After all the instrument configurations have been set as required, it is possible to begin the sampling program.  
If the you are using the meter in Direct Reading or Both Mode, this is achieved by selecting Run from the 
Setup menu.  The unit enters an interrupt period for 5 seconds, during which the message Initialising is 
displayed in the bottom left hand corner of the Window.  Following this, the unit enters Run mode.  
 
To run the unit in Logging only mode, either select Run from the Setup menu, or submerge the unit. 
 
In all cases, the unit will not function until it is submerged.  To conserve battery life, the unit is fitted with a 
sea switch mechanism that prevents it working unless it is underwater.  To bypass this when workshop 
testing, it is necessary to fit the crocodile clips provided to the back of the unit.  See the main Unit Operation 
Manual for details of how to do this. 
 
To see real time Direct Reading data, use one of the display modes detailed in Section 5, by selecting the 
appropriate command from the Display pull down menu. 
 

4.2 RECORD 

It is possible for Direct Reading data to be recorded on computer disk.  After the desired configuration has 
been set in the Connect Screen, select Record from the File pull down menu.  You will be asked to specify a 
drive, directory and file name for the record.  Then proceed to run the unit as above.  The data will 
automatically be recorded as it is produced. 
 
In order to view direct reading data, you must select a display mode from the Display pull down menu.  Full 
details on these modes are in Section 5.3. 
 

4.3 STOP 

To stop the unit Running in Direct Reading or Both modes, select Stop from the Setup pull down menu.  The 
unit will also stop if Connect is selected.  The unit must be stopped in order to allow certain functions to be 
used in the displaying of data.  See Section 5 for further details. 
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5 DATA HANDLING 

5.1 UPLOADING LOGGED DATA 

Data are stored in internal battery backed RAM in binary format. Each time the unit is switched on or 'RUN' , 
a new data file is created with its own header information containing averaging period etc. following which 
the data is recorded. These data files can be uploaded and saved to disk by selecting Extract from the Connect 
screen in Setup. A binary file is created initially which mirrors the requested stored data files; the default 
name is RAW.  
 
Calibrated files (default name CAL) are created from the binary files. 
 
The Calibrated files can later be displayed in the various formats available with this package or imported into 
spreadsheets for statistical analysis. 
 
The Display will now show the following: 
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i) Data Areas:  Scrollable text box containing file allocation within the instrument. If no data 
has been stored in the instrument, the message 'Nothing to upload' will be 
displayed. 

 
ii)  Raw filename:   Binary format files in non engineering units. The default filename RAW may be 

changed; it should be restricted to 8 characters. 
 
iii) Calibrated filename: Calibrated files generated from RAW binary files.  The default filename CAL may 

be changed; it should be restricted to 8 characters. 
 
iv) Data directory Standard type Dialog box to allow alternative directory paths to be set.  The 

default path is c:\datalog. 
 
A header file is created as default, which contains various information about the file, with the following 
structure. To override this, select make Separate Header File. 
 
 

File header created by DataLog on 03/08/99 16:33:54 
Device: BFM308, Serial number: 18564 
Header text: VALEPORT 105 
Mode: TIME_SAMPLE 
Sample period (x5 secs): 3, Average period: 1 
Impeller coefficients: 17 +1.4143845e-19 -3.5458315e-11 +2.4820728e-09 -5.5286880e-10 
 -4.8346085e-06 +1.6050182e-04 +5.6165843e-02 +1.7216420e-0 
Speed of sound formula Chen & Millero 

 
 

As many files as you want can be selected at once with the mouse by holding down Ctrl while using the 
mouse to click on each file.  Once the desired files have been highlighted, select Upload.  Initially the RAW 
binary files will be created with an extension relating to file number e.g. RAW.005 corresponds to file number 
5 in the instrument.  The Calibrated data files are created using the same extension as the binary files from 
which they were created.  
 
Note that the data in the instrument is not erased after uploading, further logging will occur after the last 
record. 
 

5.2 SAVED DATA 

If you wish to look at data already on the computer, either Uploaded from the unit or recorded from Direct 
Reading mode, select Open from the File menu.  Select the desired drive, directory and file and push Enter.  
The correct file will then be opened. 
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5.3 DISPLAYS 

Data from the unit can be displayed in 5 formats.  Several different displays can be shown simultaneously and 
iconized. 
 
For  Direct Reading Display 

5.3.1 BRIEF 

The Brief display will show the parameters transmitted by the instrument in real time mode only. It should be 
noted that data will only be updated at the end of an averaging period.  Data stored on disk cannot be 
displayed in this format.  
 
This display is not sizeable, but can be iconized and moved outside the DataLog environment. 
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5.3.2 FULL 

The Full display is provided primarily for use with other Valeport instruments, and provides a display of 
calculated parameters as well as the measured ones available under the Brief display.  Since the Models 104 
and 105 do not have the option of a Conductivity sensor, calculation of these additional parameters is not 
possible.  The unavailable parameters are shown in italics and are not updated. 
 
Use of this display is not recommended with the Model105 - use the Brief display instead. 
 
 

 



Valeport Limited 

DataLog Operation Manual Page 18 0300845A.DOC 

5.3.3 SCROLL 

As the title suggests, a Scrolled display will be shown as below. The most recent data will be displayed at the 
top therefore scrolling data down. To view information outside the text box, shift the display using the arrow 
controls with the mouse. Unlike the Brief and Full display options, data previously stored from real time 
recording (see sections 4.1 & 5.2) or Uploaded from the instrument (see section 5.1) can be recalled and 
displayed in this format. The example below shows a typical scrolled display of recorded data from a Model 
105 Current Meter. 
 

 
 
Data displayed in this format can be printed, but not while the unit is actually running.  If this screen is being 
used for real time display, Stop or Connect must be selected to allow data printing.  To print off a table of 
data, select Print from the Options Menu.  A standard Windows Print Options form will be displayed. 
 
It is also possible to select the font in which the data is to be printed.  Selecting Set Print Font before selecting 
the Print function reveals a display showing all available printer fonts.  NB Some TrueType fonts will not size 
to the page correctly, so use of these is not recommended. 
 

5.3.3.1 AVERAGE DATA 

A display of average data values can be obtained from this screen.  While the unit is stopped (or with 
recorded/uploaded data), the Scroll table has the property of allowing values within the table to be 
highlighted.  This can be done either by dragging the mouse over the desired values, or by clicking on a 
column header to select the entire column.  Then select Data Analysis from the Display menu.  A table will 
be displayed, showing high and low values, the mean value of the data, and the Standard Deviation of the 
data. 
 
NOTE: It is not possible to perform Data Analysis on more than one parameter at once. 
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5.3.4  GRAPH 

The Graphical display function can be used for either real time or recorded data, and allows each parameter  
of the instrument to be displayed as a function of time or pressure. The outputs provided show the parameter 
type by way of engineering units; the 'Y' axes can be scaled individually but the 'X' axis can only be scaled 
for all parameters within each graph.  To select more than one parameter for display on the same graph, use 
Ctrl and the mouse to click on each in the Dialog box.  Several individual graphs can be displayed at once, 
the limitations of which would depend upon PC configuration and the number of tasks running in the 
WINDOWS environment, such as statistical analysis packages, word processor etc. 
 
Graphical representation can be made of any of the parameters of an instrument in real time mode once   
connection has been established. Each graph may be iconized, but will still be refreshed as new data appears.  
A hard copy of the plot can be produced by selecting the pulldown menu Files and selecting Print which will 
then show a standard type Dialog box from which print resolution, no. of copies etc. can be chosen. 
 
A typical graph is shown below as a function of Time. 
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5.3.4.1 GRAPH SETTINGS 

 
Selecting Graph Settings from the Options menu in graph mode allows the user to change certain features of 
the display.  Shown below is the settings Dialog box, to allow changes to be made to 'X' and 'Y' axes scales, 
and parameter display colour.  Select the parameter, in the example below this is Pressure, and enter new 
maximum and minimum value for the scale. The colour can be changed by selecting Colour, from which a 
set of basic and custom colours may be selected to suit. 
 
As mentioned previously, the time axis can be changed, but this will be for all parameters displayed. Simply 
select Start time and enter required date/time, then select End time and enter as appropriate.  
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5.3.5 SCATTERPLOT 

Speed and Direction data from a Model 105 can also be represented on a Scatterplot diagram.  This function 
is available for viewing logged data or for real time viewing.  The scroll button on the right of the display is a 
zoom function.  This screen can also be printed by selecting Print from the File menu.  This function is not 
available with data from a Model 104 Flow Meter. 
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5.4 OPTIONS 

This function allows the user to set various options as detailed below.  Some functions are only available at 
specific points within the software.  At all times, Options allows the user to select/de-select the status line at 
the bottom of the page 
 

5.4.1  STATUS LINE 

The Status line in situated at the bottom of the DataLog window. Real time data/filename and PC time and 
Date are displayed here. This can be toggled on/off by selecting Status Line with the mouse. 
 

5.4.2  CONSTANTS 

Select either the UK nautical mile (1853.18 metres) or International nautical mile (1852 metres) as required 
followed by OK to confirm. 
 

5.4.3  UNITS 

The units of speed can be selected as below (OK to confirm). 
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5.4.4 TEST FORMULA 

A feature of DataLog is its Test Formula Option.  Selecting Test Formula from the Options Menu reveals the 
following display, which allows the user to calculate Density Anomaly, Salinity/Conductivity, Speed of Sound 
using a formula of their choice, and to perform a Depth/Pressure calculation. 
The following display is revealed, and an explanation of each function is given below: 
 

 

5.4.4.1 USER INPUT VALUES 

CONDUCTIVITY/SALINITY 
The user has the option to input either Conductivity (mS/cm) or Salinity (PSU).  Click on either to select 
(highlight), or click the check box.  The program will calculate whichever is not input. 
 

PRESSURE 
Enter the required pressure in decibars. 

 
TEMPERATURE 

It is possible to use either IPTS-68 or IPTS-90 temperature values in the calculations.  Simply click on the 
desired scale or the check box to select. 

 
LATITUDE 

This is required to correct for local gravity, which is required in depth calculations for Speed of  
Sound [for all formulae with the exception of Chen & Millero 1977]. Enter the geographical latitude for 
the measurement site, using a negative number if South of the equator. 

 
CHANGE SPEED OF SOUND FORMULA 
 The user can select a formula with the Change Speed of Sound Formula button.  Note that for all 

formulae apart from Chen & Millero, geographical latitude must be input.  Clicking the Calculate button 
then reveals the Speed of Sound as calculated using the selected formula.  This has no effect on the 
formula used by the software for the Speed of Sound in Running Mode. 
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5.4.4.2 CALCULATED PARAMETERS 

The formulae used for calculating Density Anomaly γ, Salinity, Depth and Speed of Sound are complex, and 
are not given here.  They are available, if required, by contacting Valeport.  Conductivity is calculated from 
Salinity using a Newton Raphson Iteration of the Salinity formula.  Salinity and Conductivity are self 
explanatory functions.  Speed of Sound can be calculated using various formulae (user selectable under 
Change Speed of Sound Formula).  The default formula is Chen & Millero (1977).  For details of this and the 
other available formulae, contact Valeport.  Density Anomaly γ and Depth require further explanation: 
 

Density anomaly γ This is Density (ρ)  - 1000 
 

Depth This is based on the Simple UNESCO Depth formula which is based on 
assuming a salinity of 35 PSU and temperature of 0 °C. For simple calculations 
of depth for different densities, the standard depth can be corrected by 
multiplying it by the ratio of average density over depth of 35PSU, 0 °C water to 
the average density of the actual water column.  

 
e.g. 
Standard Depth [35,0] for 1000 dBar at 0 latitude = 992.117 metres 
 
Average density [approx.] over 1000dbar range for [35,0] seawater  
    = [Density at 0 dBar + Density at 1000 dBar]/2 
    = [1028.1 + 1032.8]/2 
    = 1030.45 kg/M3 
  
Average density from data, using Data Analysis function [see section 5.3.3.1] 
    = 1027.6 [example number only for calculation] 
 
Density ratio   = 1030.45/1027.6 
    = 1.0028 
 
Revised depth estimate = 992.117 * 1.0028 
    = 994.895 metres 
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5.4.5 SPLIT SPREADSHEET 

If a saved datafile is very large, the user may find it easier to split the file into a number of smaller files for ease 
of analysis.  If this is required, select Split Spreadsheet from the Options menu.  A display similar to that 
shown below will appear.  Select the file to be split, and choose a new name for the smaller files.  By default, 
the new extensions to the smaller files will be of the form .000, .001, .002 etc. 
 
The user is also invited to select the size of the new files (Number of Lines per File). 
 

 
 
Each new file will have the same Header information as the original, but the fact that it is a Split Spreadsheet 
will also be indicated. 
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5.5  WINDOW 

The Window pull down menu allows the user to configure the display to either Cascade, Tile or Arrange 
Icons if showing. It should be noted however that the Brief and Full displays are not affected by this command 
as they are created for display outside the DataLog window.  
 

5.5.1 CASCADE 

Below is an example of a cascaded display. 
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5.5.2 TILE 

Below is an example of a Tiled display. 
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5.5.3 ARRANGE ICONS 

Shown below is an example of the above function with a scatterplot display. 
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5.6  ABOUT 

To enable the user to determine which software version is operating, select  the About function.  A display 
similar to below will be shown which contains information with regard to PC configuration. 
 
 

 
 

 


